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ABOUT THE BOOK

This is the most comprehensive book about AutoCAD 2016 — 2D drafting on the

market. It is divided into three major parts:

Essentials: from Chapter one to Chapter ten. It assumes that the reader has no
previous experience in AutoCAD; hence it starts from scratch. Chapter ten contains
three projects — one architectural, and two mechanical using both Imperial and metric
units.

Intermediate: from Chapter 11 to Chapter 18. It contains a deeper discussion on a
subject we touched on in the Essentials part, or a new advance feature.

e Advanced: from Chapter 19 to Chapter 25. It discusses the most advanced features of

AutoCAD 2016.

If you don’t have any prior experience in AutoCAD this book is a perfect start, and

you can stop at the end of any part. But if you want to be a real power user of AutoCAD,
you should go through all the 25 chapters, solving all projects and practices.

This book is also a good source to prepare for the AutoCAD Certified Professional

exain.

The chapters are divided as follows:

Chapter (1) covers AutoCAD basics along with the interface

Chapter (2) covers AutoCAD techniques to draw with accuracy

Chapters (3 & 4) cover all modifying commands

Chapter (5) covers the AutoCAD method of organizing the drawing using layers and
inquiry commands

Chapter (6) covers the methods of creating and editing blocks, and inserting and
editing hatches

Chapter (7) covers AutoCAD methods of writing text

Chapter (8) covers how to create and edit dimensions in AutoCAD

Chapter (9) covers how to plot your drawing

Chapter (10) three projects, one architectural and two mechanical, covering both
metric and imperial units

Chapter (11) covers the creation of more 2D objects

Chapters (12 & 13) cover advanced practices and techniques

Chapter (14) covers Block tools and Block Editing

Chapter (15) covers the creation of Text Style and Table Styles along with Formulas
in tables

Chapter (16) covers the creation of Dimension Style & Multileader style plus adding
multileaders

Chapter (17) covers the creation of Plot styles, the meaning of Annotative, and DWF
creation

Chapter (18) covers how to create a template file and customize AutoCAD interface



Chapter (19) covers Parametric Constraints

Chapter (20) covers Dynamic Blocks

Chapter (21) covers Block Attributes

Chapter (22) covers External Reference

Chapter (23) covers Sheets Sets

Chapter (24) covers CAD Standards and advanced layer commands
Chapter (25) covers Drawing Review



B REFACE

Since its inception, AutoCAD has enjoyed a very large user base, which has made it
the most used CAD software in the world.

AutoCAD is widespread due to its logic and simplicity, which makes it very easy to
learn.

AutoCAD evolved through the years to become a comprehensive software
application addressing all aspects of engineering drafting and designing.

This book addresses all levels of AutoCAD 2D drafting, Essentials, Intermediate, and
Advanced, which makes it ideal for novice users, and for those seeking to be
professional power users ready for industry.

This book is not a replacement of AutoCAD manuals, but is considered to be a
complementary source that includes hundreds of hands-on practices to strengthen the
knowledge learned and solidify the techniques discussed.

At the end of each chapter, the reader will find “Chapter Review Questions” which
are the same sort of questions you may see in the Autodesk certification exam; so the
reader is invited to solve them all. Correct answers are at the end of each chapter.
Chapter 10 contains three projects: one is an architectural plan, presented in metric
and imperial units. The other two projects are for mechanical engineering. One of
them is thoroughly explained and the other is not! These two projects are also
presented in both metric and imperial units.



ABOUT THE COMPANION DISC

Included in the book is a CD-ROM which contains the following items:

e A link to retrieve the AutoCAD 2016 trial version, which will last for 30 days starting
from the day of installation. This version will help you solve all practices and
projects (if you are a college/university student, you can download a student version
of the software from www.autodesk.com)

e Practice files which will be your starting point to solve all practices in the book

e Copy the folder named “Practices” into one of the hard drives of your computer

e As for projects, you will find two folders inside, “Metric” for metric units projects,
and “Imperial” for imperial units projects

e All of the companion files on the CD are also available for downloading from the
publisher by writing to info@merclearning.com
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CHAPTER 1

AUTOCAD 2016 BASICS

In This Chapter

Starting AutoCAD
Dealing with the AutoCAD interface
AutoCAD defaults and drawing units

Dealing with file-oriented commands
Undo and Redo commands

1.1 STARTING AUTOCAD

AutoCAD was released in 1982 by Autodesk, Inc., which was a small company at
that time. It was designed to be used for PCs only. Since then AutoCAD has enjoyed the
biggest user base in the world in the CAD business. Users can use AutoCAD for both 2D
and 3D drafting and designing. AutoCAD can be used for architectural, structural,
mechanical, electrical, environmental, and manufacturing drawings and for road and
highway designs.

Though the focus these days is BIM (Building Information Modeling), AutoCAD is
still the most profitable software for Autodesk, Inc. due to its ease of use and
comprehensiveness, which address all user needs. Another version of AutoCAD, called
AutoCAD LT, is used for 2D drafting only.

To start AutoCAD 2016, double-click the shortcut on your desktop that was created
in the installation process. AutoCAD will show the Welcome window, which looks like
the following:



Start Drawing

ﬁ Templates v

Sign In to A260
Access online services.

Send Feedback
Help us improve our products

CREATE @)

As you can see at the bottom, there are two choices: CREATE and LEARN. In the
current figure you are seeing the CREATE part. While you are in this part you can:

e Start a new drawing

e Open an existing file

e Open a Sheet Set

e Download more templates accessed online

e Explore the sample files that come with the software

e See the recent files you opened

e Check if AutoCAD has a notification for you concerning your software/hardware
e Connect to Autodesk 360 (Autodesk Cloud)

e Send your feedback to Autodesk

At the bottom, click the LEARN option to see the following:



Annotation *

[ ]
Use MATCHPROP @ to copy all
layer property overrides from one
layout viewport to another. Ensure
that Viewport checkbox s selected in

the Properties Settings dialog box.

Create Objects
rfa.e., _J_e- D obie Mare information...

AutoCAD 2015 New Features Overview

Morlily Objces Evplore training materials on the
web to sharpen your skills or learn

something new.

The Hitchhiker's Guide:
s AudoCAD Basia
= e
=

Hitchhiker's AutoCAD Basics

CREATE

You will see in this part the following:

e Videos of the new features of AutoCAD 2016

e Other videos discussing features of AutoCAD 2016, like how to use some modifying
commands in AutoCAD

e Tips from Autodesk (normally you will see different tips every time you start

AutoCAD)
e Some online sources to help and train you like Hitchhiker videos and Lynda.com

Starting a new file or opening an existing file will show you the interface of
AutoCAD 2016, which will look like the following:

= = .
i | 0| =
Group Utilities | Chipboard |  View

»| Groups » - - - |

ne Polyline Lr\e Ac

Draw «

" Mechanical-2

[—[Topl{2D Yireframe]

Y@ ® ®
@
L%
_Ec-nnd: _Am
. e |l T | st
| Model | Toditi Jteyouiz '+ J 1202461, -8.8898,00000 MODEL i} " » FU_ L @G-V~ LN EH aR- A -8+ P @B &A=



. Application Menu
. Start tab

. File tab

. Ribbon

. Workspace

. Info Center

. Autodesk 360

. ViewCube

© 0 N O U1 A W N

. Navigation Bar

10. Cross Hairs

11. Status Bar

12. Command window
13. Layout tab

14. Model tab

15. Graphical Area

1.2 AUTOCAD 2016 INTERFACE

The AutoCAD interface is based on Ribbons and the Application Menu. The most
important feature of this interface is that the size of the Graphical Area will be bigger.

1.2.1 Application Menu

The Application menu contains file-related commands:



Search Commands Q
L 4

0B &) Recent Documents
By Ordered List v| (5] +

Mechanical-1.dwg (=

% Open » Floor Plan Sample.dwg -

E E:Lapltrttr’;c;ion and Multileaders -
Save .

E Assembly Sample.dwg =2

Suite
Z’ Workflow »
s

Included are commands such as creating a new file, opening an existing file, saving
the current file, saving the current file under a new name and in a different folder,
exporting the current file to a different file format, printing and publishing the current file,



etc. We will discuss almost all of these commands in different places in this book. By
default, you will see the recent files. You can choose how to display the recent files in the
Application Menu using this control:

- B

' Small Icons

>Ol

Large Icons
B.d'

Small Images
Iw

Large Images
iwg

Also, you can choose how to sort the recent files using this control:

By Ordered List « l@ -

v/ By Ordered List
3.dwi
By Access Date
J
By Size
By Type

™ Practice 1-4.cddwn

1.2.2 Quick Access Toolbar

This toolbar contains all File commands mentioned in the Application Menu along
with Workspace and Undo/Redo.

OhedBoR @ -5

The user can customize this toolbar by clicking the arrow at the end, which will bring
up the following:
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Customize Quick Access Toolbar
v New

« Open

v Save

v Save As...
v Plot

v Undo

v Redo

Workspace
Match Properties
Batch Plot

Plot Preview
Properties

Sheet Set Manager

Render

More Commands...
Show Menu Bar

Show Below the Ribbon

As you can see, the user can add or remove commands; clicking Show Menu Bar
may also be useful because the ribbon doesn’t include all AutoCAD commands.

1.2.3 Ribbons

Ribbons consist of two parts: tabs and panels, as shown below:



Standard - |<—o| Part Dim -

Find text %, § S A ] Quick

Dimension
2000 = " |'~7'| |'_¢:| ?EI {14 Continue -
Text ~ ’i Dimensions ~ s

Tab

Some panels have more buttons than shown: the following is the Modify panel:
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o | [3\ Stretch )] Scale 33 Array + | &
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Click the small triangle near the title and you will get the following:
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If you move away from the panel, buttons will disappear. To make them visible
always, click the push pin. The new view will be as follows:
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For some commands, there are many options. To make the user’s life easier,
AutoCAD put all the options in the same button. Check the following illustration:

ik re

Line Polyline Circle Arc

Draw =

The ribbons have a very simple help feature. If you hover the mouse over a button, a
small help screen comes up:

q.E-p Move o Rotate '.r"ll:" Trim ~ _é
G Copy |4A Mirror| (7] Fillet ~

2\ Stretch /il S

Mirror
M

Creates a mirrored copy of selected objects

‘= MIRROR
Press F1 for more help

If the user leaves the mouse over the button for a longer period of time, AutoCAD
will show more detailed help:



tE* Move O Rotate -/ Trim =~ _.f
% Copy [4h Miror| (7] Fillet ~ |¢§v

[2\ Stretch [l S¢

M Mirror

Creates a mirrored copy of selected objects

You can create objects that represent half of a drawing, select
them, and mirror them across a specified line to create the other
half.

; MIRROR
Press F1 for more help

Other buttons may have video help, like the following:



+§+ Maowve {:} Rotate - Trim - _@f
S Copy  Ah Mirror (] Fillet - @59

[_,1‘. Stretch E Scale EE Array : P
Modify =

3
Rectangular Array

Distributes ohject copies into any combination of rows, columns,
and levels.

Creates an array of rows and columns of copies of the selected
object.

%

‘= ARRAYRECT

Press F1 for more help

Panels have two states—either docked or floating. By default all panels are docked in
their respective tab. Drag and drop the panel in the graphical area to make it floating. One
important feature of making the panel floating is you will be able to see it while other tabs
are active.

You can send the panel back to its respective tab by clicking the small button at the
top right side:

1.§-|. Move O Rotate -a"'ll:" Trim ~ .é_._.
O&) Copy ,jlh Mirror Q Fillet ~ v

[\ Stretch )] Scale 33 Array ~ &
Modify ~

Return Panels to Ribbon

While the panel is floating you can toggle the orientation:
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It will either extend to the right:

+§+ Maowve {:} Rotate - Trim - _‘Z
S Copy  Ah Mirror (] Fillet - @59
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Or down:
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The button at the end of the tab names allows you to cycle through the different states
of the ribbons. The main objective of this new feature is to give you yet more graphical
area. Clicking the small button will bring up the following:

Minimize to Tabs

Minimize to Panel Titles

Minimize to Panel Buttons

Cycle through All

1.2.4 InfoCenter

InfoCenter is the place to access help topics online and offline, along with some other
tools:

i Type a keyword or phrase

For instance, if you type a word or phrase in the field shown below, AutoCAD opens
the Autodesk Exchange window and finds all the related topics online and offline. Online



means all Autodesk websites along with some popular blogs.

Use Sign In to access Autodesk Online Services. The X at the right will activate the
Autodesk Exchange Apps website. The last button at the right with the question mark will
show the following:

k| Tyve a keyword or phrase an g Sign In - K B - @

Help

Download Offline Help

Send Feedback

Download Language Packs M
las"

Customer Invohvement Program...

Desktop Analytics...

About Autodesk AutoCAD Longbow Beta 1

1.2.5 Command Window

By default the command window is floating, but you can dock it at the bottom or the
top of the screen. Reading the command window all the time will save lots of wasted time
trying to figure out what AutoCAD wants. AutoCAD will show two things at the
command window: your commands and AutoCAD prompts asking you to perform a
particular action (e.g., specify a point, input an angle, etc.). Check the following
illustration:

fr=it
'@l Arc creation direction: Counter-clockwise (hold Ctrl to switch direction).
Q 7"~ ARC Specify start point of arc or [Center]:

a

1.2.6 Graphical Area

The graphical area is your drafting area. This is where you will draw all your lines,
arcs, and circles. It is a precise environment with an XYZ space for 3D and an XY plane
for 2D. You can monitor coordinates in the left part of the status bar.

1.2.7 Status Bar

The status bar in AutoCAD contains coordinates along with important functions;
some of them are for precise drafting in 2D, and some of them are for 3D.
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Coordinates Tools

The buttons you will see on the status bar are not necessarily all that are available. To
customize this, click on the last button at the right (the one with three horizontal lines) and
you will see the following list:



v Coordinates

v Model Space

v Grid
v Snap Mode

v Infer Constraints

v Dynamic Input

v Ortho Mode
v Polar Tracking
v Isometric Drafting

v Object Snap Tracking
v 2D Object Snap

v LineWeight

v Transparency

v Selection Cycling

v 3D Object Snap

Dynamic UCS
Selection Filtering
Gizmo

Annotation Visibility

v Annotation Scale

v Workspace Switching

v Annotation Monitor

Units

Quick Properties




1.2.8 Start Tab

When you click the Start tab at any moment, you will get the welcome screen again.
Hence you can start a new drawing, open an existing drawing, etc.

1.3 AUTOCAD DEFAULTS

Before using the AutoCAD environment, you should be aware of the following
AutoCAD settings:

e AutoCAD saves points as cartesian coordinates (X,Y) whether metric or imperial
numbers were used. This is the first method of precise input in AutoCAD to type the
coordinates using the keyboard

Y axis

10 -

coordinates=7.5

OO " 1 T T T T T I T T 1 X axis

e To specify angles in AutoCAD, assume east (to your right) is your 0o and then go
counterclockwise. (This is applicable only for the northern hemisphere; we will learn
in Chapter 10 how we can change this setting for the southern hemisphere)



90 (North)

‘\ccw

(West) 180 0 (East)

|

270 (South)

The wheel in the mouse has four zooming functions: Zoom In (move wheel forward),
Zoom Out (move wheel backward), Panning (press and hold the wheel), and
Zooming Extents (double-click the wheel)

Pressing [Enter] or [Spacebar] is equal in AutoCAD

When pressing [Enter] without typing any command, AutoCAD will repeat the last
command. If it is the first thing you do in the current session, it will start Help
Pressing [Esc] will cancel the current command

Pressing [F2] will show the Text Window—check the following:



Edit

Arc creation direction: Counter-clockwise (hold Ctrl to switch direction).
Specify start point of arc or [Center]:

Specify second point of arc or [Center/End]:

Specify end point of arc:

Select objects: Specify opposite corner: 5 found
lect objects:
Specify base point or [Displacement] <Displacement>:

Specify second point or <use first point as displacement>:
ommand: ARRAY

elect objects: Specify opposite corner: 5 found

Select objects: Enter array type [Rectangular/PAth/POlar] <Rectangular>: R
ype = Rectangular Associative = Yes

Select grip to edit array or [ASsociative/Base point/COUnt/Spacing/COLumns/Ro

1.4 WHAT IS MY DRAWING UNIT?

If you draw a 6-units line in AutoCAD, what does AutoCAD really mean by 6 units?
Is it 6 m, 6 ft, or neither? AutoCAD deals with whatever units you choose; if you mean 6
m, so let it be! If you mean 6 ft, AutoCAD will go with this assumption as well. What is
important is that you be consistent throughout your file. This is true for the Model Space,
where you will do your drafting, but when it comes to printing, you have to recall your
assumption and set your drawing scale accordingly. In Chapter 9, we will discuss printing.
At the bottom left of the screen you can see the model tab and the layouts, just like the
following:

4 Plan A Section Elevation I'f'-‘_,'

Model tab Layout tabs

1.5 CREATE ANEW AUTOCAD DRAWING

This command will create a new drawing based on a premade template. Use the
Quick Access Toolbar and click the New button:




/ o Creates a blank drawing file c:

Line Pq ;QHEW

Press F1 for more help i
Drawing
Or you can click the (+) sign in the File tab:
Line Polyline Circle Arc “— = —-rs P
) . ]ﬁ b E“l Stretch ﬁ Scz
Draw ~ Ma

[=1[Topl[2D Wireframe]
Plus sign in the File tab

You will see the following dialog box:

Look in: |1.Template vl & E} ﬁ 3 E_ Views = Toos -

Mame Dat: Preview

L PTWTemplates 1/1¢

| SheetSets ifak
acad -Named Plot Styles 12/t
acad -Named Plot Styles3D 12/¢
g acad 12/¢
g acad3D 12/¢
g acad|SO -Named Plot Styles 14717
g acad|SO -Named Plot Styles3D 1117
] acadiso 71
g acadiso3D U
g Tutorial-iArch U
[ Tutorial-iMfg 12/¢
gl Tutorial-mArch Ty
[ Tutorial-mMfg W1

File name: | acad

Files of type: | Drawing Template (*.dwt)

Do the following steps:



e Select the desired template file (AutoCAD template files have the extension *.dwt).
AutoCAD 2016 comes with lots of premade templates that you can use (it is
preferable for the companies to create their own template files).

¢ Once you are done, click the Open button

e AutoCAD drawing files have a file extension of *.dwg

e AutoCAD will start with a new file (which has a temporary name like
Drawing1.dwg; you should rename it to something meaningful)

In the Start tab under the Start Drawing section, you can use the Template
NOTE drop-down list to choose from the existing templates to start a new file, just
like the following:

Start Drawing

H Templates v
Existing
acad -Mamed Plot Styles.dwt
'/’ by _\\‘ Templates

acad -Mamed Plot Styles3D.dwt
acad.dwt

acad3D, dwt

acadl5C -Named Plot Styles.dwt

l‘-\_ar:auszE.Cr -Mamed Plot Stj.-'les3D.dwt_/-"
Sheet Sets

ET' Create New Sheet Set...

1.6 OPEN AN EXISTING AUTOCAD DRAWING

This command will open an existing drawing file for additional modifications. From
the Quick Access Toolbar, click the Open button:

Opens an existing drawing file

Line Polylin ;I}PEH

Press F1 for more help
T

ST TN TR——,



You will see the following dialog box:

Lookin: | |, Chapter 01 v @B @ X E Vews v Toos ~

Mame Dat:  Preview
[ i@ Mira Villa - 3D 11

il Mira Villa - First Floor 3/1:

ii Mira Villa - Ground Floor

[] Select Inttial View

Flename: | Mia Villa - 3D

Files of type: | Drawing ("dwa)

Take the following steps:

e Specify your desired drive and folder

e You can open a single file by selecting its name from the list and clicking the Open
button, or you can double-click on the file’s name. Or, you can open more than one
file by selecting the first file name, holding the [Ctrl] key, clicking the other file
names in the list (which is a common MS Windows skill), and then clicking the
Open button.

1.6.1 File Tab

Using the File tab beneath the ribbon, you will see a tab for each opened file, as in
the following:

Lrdw - | Iy

The color used is gray. The current file (tab) will appear in a lighter gray, and the
other tabs will appear in a darker gray. If you hover over one of the tabs, two things will



take place:

e The path of this file will appear above the tab
e The model space and the layouts of this file will appear beneath

Check the following:

+0 | SR (ST [ 1 Rttt} — | W N T TR | PEE) TR

3D View Some Arch Details

There will be a blue frame around the model space view. Moving your mouse to the

right will show the layouts in the graphical area; if you find what you are looking for, click
the layout view to move to it.

e A star beside the name of the file in the file tab means this file was changed
and you need to save changes
e Click (x) beside the name to close the file, hence closing the tab
e The user can customize the File tabs and the Layout tabs by switching them
off
e All you have to do is to go to the View tab and locate the Interface panel;
r— the two buttons will be blue if the tabs are on, but if you want to turn them
off, click once on each button:

I__|+" 'S Tile Horizontally
e = N

: [l Tile vertically
Switch | |- File Layout
Windows| | Tabs | Tabs || Cascade

nterface ]

1.7 CLOSING DRAWING FILES

This command will close the current opened files or all opened files, depending on
the command you choose. Use the Application Menu, move your mouse to the Close
button, then select either Current Drawing to close the current file, or All Drawings to
close all the opened files in single command:




|5€ar-:.'1 Commands 34

I@I@ Close the drawing

D MNew ] Current Drawing

Bl Close the current drawing.

E Open ¥ e 0

Close all currently open drawings.

=

@ Publish b
@ Print [

Suite
Workflow »
5

L5 Drawing b
22| Utilities

a Close 4

If any of the open files were modified, AutoCAD will ask if you want to save or
close without saving, as in the following dialog box:

0 Save changes to Ch\Users\Munir\Desktopi\Mechanical-2.dwg?

1.8 UNDO AND REDO COMMANDS

Undo and Redo are to help you to correct mistakes. They can be used in the current
session only.

1.8.1 Undo Command

This command will undo the effects of the last command. You can reach this



command by going to the Quick Access toolbar and clicking the Undo button. If you
want to undo several commands, click the small arrow at the right. You will see a list of
the commands; select the group and undo them:

<R

- {o} Drafting & Annotation

ey O arae o ot rie Wiew

Also, you can type u at the command window (don’t type undo, because it has a
different meaning), or press Ctrl + Z at the keyboard.

1.8.2 Redo Command

This command will undo the undo command. You can reach this command by going
to the Quick Access toolbar and clicking the Redo button. If you want to redo several
commands, click the small arrow at the right. You will see a list of the commands; select
the group and redo them:

{@} Drafting & Annotation -

Redo

Reverses the effects of the previous UNDO or U command

Er ay
re o '=m REDO
Press F1 for more help I
e £ I
P ——

Also, you can type redo at the command window or press Ctrl + Y.

PRACTICE 1-1
AutoCAD Basics

Start AutoCAD 2016
2. Open the following files:

1. Ground Floor

2. Mechanical-1

3. Mechanical-2
Using the File tab, check the three files and their layouts
Use the different zoom techniques with the mouse wheel
Using the Application menu, close all files without saving

—

ok w



NOTES

CHAPTER REVIEW

1. The File tab will show the Model space and layouts of the opened files
1. True
2. False
2. The AutoCAD template file extension is
1. *.dwt
2. *.dwg
3. *.tmp
4, *.temp
3. AutoCAD units can be a meter or foot, per user desire
1. True
2. False
Moving the wheel forward will mean
To undo any command in AutoCAD you can:
1. Click the Undo icon from the Quick Access Toolbar
2. Type u at the command window
3. Type [Ctrl] + Z
4. All of the above
6. Ribbons consist of and

>

o

7. The Menu bar by default is not shown, but I can show it if I want to:
1. True
2. False
The AutoCAD drawing file extension is
9. Positive angles in AutoCAD are created by moving in this

&0

CHAPTER REVIEW ANSWERS
1.a

3.a

5.d

7.a

9. CCW (counterclockwise)

direction:



CHAPTER ?

PRECISE DRAFTING IN
AUTOCAD 2016

In This Chapter

What are the drafting priorities?

How to draw lines, circles, and arcs using precise methods
How to draw polylines using precise methods

How to convert lines and arcs to polylines and vice versa

What are Object Snap and Object Track?

2.1 DRAFTING PRIORITIES

While you are drafting, there are two main concerns in your mind: the accuracy of
your drawing and how fast you can finish it. People crave to finish their drawings fast, but
without weakening the drawing’s accuracy. Experts tend to put accuracy ahead of fast
production.

Accuracy is important in the context of the “life cycle” of the drawing. If your
drawing is accurate, all the other people who will modify it in the future will be able to do
their mission without hassle. On the other hand, their lives will be miserable if you
finished your drawing fast, but none of the objects are accurate.

In this chapter you will learn how to use the four most important drafting commands,
which are:

e Line command, to draw line segments

e Arc command, to draw circular arcs

e (Circle command, to draw circles

e Polyline command, to draw lines and arcs jointly

While we are discussing the four drafting commands, we will introduce accuracy
tools, which will help you speed up the drafting process.

2.2 DRAWING LINES USING LINE COMMAND

This command will enable you to draw straight lines; each line segment presents a
single object. To issue this command go to the Home tab, locate the Draw panel, and then
select the Line button:




) =
Line |Polyline Circle Arc

N R 1k

e

Line

Creates straight line segments

= LINE

Press F1 for more help

You will see the following AutoCAD prompts:
Specify first point:
Specify next point or [Undo]:
Specify next point or [Undo]:
Specify next point or [Close/Undo]:
Using the first prompt, specify the coordinates of your first point. Keep specifying

points, and when you are done, do one of the following:

e If you want to stop without closing the shape, simply press [Enter] ([Esc] will do the
job as well, but don’t make it a habit, as [Esc] generally means abort)

¢ If you want to close the shape and finish the command, press C on the keyboard or
right-click and select the Close option

¢ If you made any mistakes, you can undo the last point by typing U on the keyboard
or right-clicking and selecting the Undo option

This is what the right-click menu looks like:



Enter
Cancel
Recent Input »

Close
Undo

Snap Overrides »

Q’l Zoom

(@) SteeringWheels

QuickCalc

2.3 WHAT IS DYNAMIC INPUT IN AUTOCAD?

Dynamic Input has multiple functions:

e [t will show all the prompts at the command window in the graphical area
e It will show the lengths and angles of the lines before drafting, which will specify



them accurately

In order to turn on/off the Dynamic Input, click the following button on the Status
bar:

Dynamic Input - On
DYNMODE

M e P +.RLG'\L'LD'

A

2.3.1 Example for Showing Prompts

By default if you type any command using the command window, AutoCAD will
help you by showing all the commands starting with the same letters, as in the following
example:

M (MOVE)
EX MA (MATCHPROP)
7 MTEDIT
ii MI (MIRROR)
Po MS (MSPACE)
e MEA (MEASUREGEOM)

B MO (PROPERTIES)

We typed the letter m, and accordingly AutoCAD gave us all the commands starting
with this letter. While Dynamic Input is on, this is applicable to the crosshairs as well, as
in the following:



[ a'm |
L

M

+§+ ~
(%, MA (MATCHPROP)

A2 MTEDIT

A\ M1 (MIRROR)

MS (MSPACE)

= MEA (MEASUREGEOM)

] MO (PROPERTIES) v

Let’s assume we started the command window, using either way. Once you press
[Enter], the following prompt will appear:

St o ] 2 | 75

Type in the x and y coordinates, using the [Tab] key to move between the two fields:

S ][ %

2.3.2 Example for Specifying L.engths and Angles

Once you specify the starting point, AutoCAD will use Dynamic Input to show the



length and the angle of the line using rubber band mode:

Angles are measured CCW starting from the east, but only for 180°, unlike the

AL angle system in AutoCAD, which will be for the whole 360°.

Type the length of the line, then using [Tab] input the angle (it will give 1°
increments); once you are done, press [Enter] to specify the first line. Continue doing the
same for the other segments:

]

PRACTICE 2-1 DRAWING LINES USING DYNAMIC INPUT

f—

Start AutoCAD 2016

Open file Practice 2-1.dwg

3. Using status bar, click off, Polar Tracking, Ortho, and Object Snap, and make sure
Dynamic Input is on

4. Draw the following shape, using 0,0 as your start point, bearing in mind all sides = 4,

and all angles are multiples of 45°:

N



0.0

5. Save the file and close it

2.4 EXACT ANGLES (ORTHO VS. POLAR TRACKING)

When using Dynamic Input angles are incremented by 1°, but still the user can’t
depend on it to specify angles precisely in AutoCAD.

The Ortho function will force the lines to be at right angles (orthogonal) using the
following angles: 0, 90, 180, and 270.

In order to turn on/off the Ortho, use the following button in the status bar:



Restrict cursor orthogonally - On
ORTHOMODE (F8)

However, what if we want to use other angles such as 30, 45, 60, etc.? Ortho will not
help in this case; for this reason AutoCAD introduced another function called Polar
Tracking, which will show in the graphical area rays starting from the current point
heading toward angles like 30, 45, etc., and based on the settings, the user can specify
angles. Since Ortho and Polar Tracking contradict each other, when you switch one on, the
other will be turned off automatically.

In order to turn on/off Polar Tracking, use the following button in the status bar:

Restrict cursor to specified angles - On
Polar Tracking (F10)

17.7131,3.7551,0.0000 #f i ~ L C&' LS 4 bl b D

If you click the small triangle at the right of the button, you will see the following
menu:



v 90, 180, 270, 360...
45, 90, 135, 180...
30, 60, 90, 120...
23, 45, 68, 90...
18, 36, 54, 72...

15, 30, 45, 60...
10, 20, 30, 40...
5,10, 15, 20...

Tracking Settings...

You can select the desired angle or select Tracking Settings to change some of the



default settings of Polar Tracking. You will see the following dialog box:

'Snap and Grd | ing | Obj 3D Object Snap | Dynamic Input
[¥] Polar Tracking On (F10)
Polar Angle Settings Object Snap Tracking Settings
Increment angle: ® Track orthogonally only
45 v () Track using al polar angle settings
V] Addtional angles
52

137 Polar Angle measurement
(@) Absolute

(O Relative to last segment

2.4.1 Increment Angle

Increment Angle is the angle to be used along with its multiples. Select one from the
list or type your own.

2.4.2 Additional Angles

If you are using 30 as your increment angle, then 45 will not be among the angles
that Polar Tracking will allow you to use. Hence, you will need to specify it as an
additional angle. However, be aware you will not use its multiples.

2.4.3 Polar Angle Measurement




When you are using Polar Tracking, you have the ability to specify angles as an
absolute angle (based on 0° at the east) or use the last line segment to be your 0 angle.
Check the following illustration:

135°

—X —— oQ°

Measured using 0.0 angle Measured using the last segment

While you control the angle using either Ortho or Polar Tracking, you can type
NOTE in the distance desired and then press [Enter] to draw accurate distances. This
method is called Direct Distance Entry.

PRACTICE 2-2 EXACT ANGLES

1. Start AutoCAD 2016

Open Practice 2-2.dwg

3. Draw the following shape (without dimension) using line command, starting from 0,0
as your starting point, bearing in mind you have to use Polar Tracking. Set the proper
Increment angle and Additional angles, using the Direct Distance Entry method to
input the exact distances:

N
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Close B 1

0,0

4. Save and close the file

2.5 PRECISE DRAFTING USING OBJECT SNAP

Object Snap, or OSNAP, is the most important accuracy tool to be used in AutoCAD
for 2D and 3D as well. It is a way to specify points on objects precisely using the
AutoCAD database stored in the drawing file.

Some of the Object Snaps are:

Endpoint: To catch the Endpoint of a line

Midpoint: To catch the Midpoint of an a line

Intersection: To catch the Intersection of two objects (any two objects)
Perpendicular: To catch the Perpendicular point on an object (any object)
Nearest: To catch a point on an object Nearest to your click point (any object)

We will discuss more object snaps when we discuss more drawing objects.

Here are graphical presentations of each one of these OSNAPs:






2.5.1 Activating Running OSNAPs

To activate running OSNAPs in the drawing, click on the Object Snap button in the
status bar:



Snap cursor to 2D reference points - On
«| | Object Snap - OSNAP (F3)

If you click the small triangle at the right of the button, you will see the following
menu:



v ./ Endpoint
v ~ Midpoint
v (©) Center
o Node
¢? Quadrant
v °{ Intersection
v —- Extension
4 Insertion
_l_ Perpendicular
O Tangent
o Nearest
o Apparent Intersection
// Parallel

Object Snap Settings...



You can switch on the desired OSNAPs one by one.

If you want to make a more convenient change, select the Object Snap Settings
option, and the following dialog box will appear:

' Snap and Grid | Polar Tracking | Obiect Snap T:*._D_Object' Snap | Dynamic Input | Quic| « [ » |
[] Object Snap On (F3) [V] Object Snap Tracking On (F11)
Object Snap modes
O V] Endpoint [ insertion Select Al

(] Pependicular . CearAl |
[_] Tangent
[_| Nearest

[ ] Apparent intersection

Intersection [ ] Parallel
; Extension

To track from an Osnap point. pause over the point while in a
command. Atracking vector appears when you move the cursor.
To stop tracking. pause over the point again.

There are two buttons at the right: Select All and Clear All. We recommend using
Clear All first and then selecting the desired OSNAPs. When done, click OK.

2.5.2 OSNAP Override

While the Object Snap button is on, several osnaps are working, and others are not!
Assume you want to temporarily switch all of them off, use a single OSNAP, and then
after finishing set everything back to normal. This is what we call OSNAP Override.

There are two ways to activate an override:



e Using the keyboard, type the first three letters of the desired osnap
e Using the keyboard, hold the [Shift] key, and then right-click. You will see the
following pop-up menu:
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P AR

a8 °\Nr GO0

Temporary track point
From

Mid Between 2 Points
Point Filters

3D Osnap

Endpoint
Midpoint
Intersection
Apparent Intersect

Extension

Center
Quadrant
Tangent

Perpendicular
Parallel

Node

Insert

Nearest

None

Osnap Settings...




PRACTICE 2-3 OBJECT SNAP (OSNAP)

1. Start AutoCAD 2016
2. Open Practice 2-3.dwg
. Check the Object Snap at the status bar and make sure that Endpoint, Midpoint,
Intersection, and Perpendicular are the only OSNAPs switched on
4. Using Object Snap and Line command, draw lines in the drawing to create the
following:

W

5. Save and close the file

2.6 DRAWING CIRCLES USING CIRCLE COMMAND

This command will draw a circle using different methods based on the available data.
If you know the coordinates of the center, there are two possible methods. If the user
knows the coordinates of points at the diameter of the circle, there are another two
methods. Finally, if there are drawn objects like lines, arcs, or other circles which can be
used as tangents for the to-be-created circles, there are two more methods. The following
are the six methods to draw a circle in AutoCAD:




D &

Input Center and Radius

Input Center and Diameter

SR

Input two points (diameter)

=

Tangent, Tangent, Radius

Input any three points

K
\_/

Tangent, Tangent, Tangent

To issue this command, go to the Home tab, locate the Draw panel, then select the
arrow near the Circle button to see all the available methods:



/D =

Line Polyline| Circle | Arc

Center, Radius

Center, Diameter

Tan, Tan, Radius

Tan, Tan, Tan

elojlexe)[JC

2.7 DRAWING CIRCULAR ARCS USING ARC COMMAND

This command will draw an arc part of a circle. To make our lives easier, AutoCAD
uses eight pieces of information related to a circular arc. These are:

e The starting point of the arc



e Any point as a second point on the parameter of the arc

¢ The ending point of the arc

e The Direction of the arc, which is the tangent that passes through the Start point. User
should input the angle of the tangent

e The distance between the starting point and the ending point which is called Length
of Chord

e The Center point of the arc

e The Radius

e The angle between Start-Center-End which is called Included Angle

Check the following illustration:

Direction

Center

If you provide three of these eight pieces of information, AutoCAD will be able to
draw an arc, but not with any three. The combination of the information needed can be
found in the Home tab, using the Draw panel, while clicking the arrow near the Arc
button to see all the available methods:



Line Polyline

Circle | A

Draw ~

/-" Start, Center, End

o

f Start, Center, Angle
o

/ Start, Center, Length
Q

ﬁa Start, End, Angle
I/ﬂ Start, End, Direction
/I Start, End, Radius

fﬂ Center, Start, End

+

f Center, Start, Angle
+

/ Center, Start, Length
+

K)ﬂ Continue




As you can see, the Start point is always required information. Normally the user
should think counterclockwise when specifying points, but if on the other hand you want
to work clockwise, simply hold the [Ctrl] key and it will change.

2.8 OBJECT SNAPS REIATED TO CIRCLES AND ARCS

Some of the Object Snaps related to circles and arcs are:

e Center: To catch the Center of an arc or circle
¢ Quadrant: To catch the Quadrant of an arc or circle
e Tangent: To catch the Tangent of an arc or circle

Here are graphical representations of each one of these OSNAPs:

/ / —K

f l H'l lffﬁ \ / | b Tangent |
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2.9 USING OBJECT SNAP TRACKING WITH OSNAP

Sometimes OSNAP alone is not enough to specify desired points, especially if we
need complex points. To solve this problem in the past we used to draw dummy objects to
help us specify complex points, like in the case when you want to specify the center of the
circle at the center of a rectangle. We used to draw a line from the midpoints of the two
vertical lines, and the same for the horizontal lines. But since the introduction of Object
Snap Tracking, or OTRACK, in AutoCAD 2000, the drawing of dummy objects
diminished. OTRACK depends on active OSNAP modes, which means if you want to use
the midpoint, OTRACK requires that you switch the midpoint on first. To activate
OTRACK go to the status bar and click the Object Snap Tracking button on:

Object Snap Tracking - AUTOSNAP (F11)

‘ihow snapping reference lines - On

28.1799, 41022,0.0000 fff iii v b @& ~ N -~ Z\:}D R R A1 $

The procedure is very simple:

e Using OSNAP go to the desired point and stand still for a couple of seconds (don’t
click), then move to the right or left (also up and down depending on the next point),
and you will see an infinite line extending in both directions (this line will be



horizontal or vertical depending on your movement).

e If you want to use a single point to specify your desired point, move to the needed
direction, type in the desired distance, and press [Enter].

e If you need two points, go the next point, and stay for a couple of seconds, then make
the movement toward the desired direction. Another infinite line will appear. Go to
the intersection point of the two infinite lines, and that will be your point.

i
*

i
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Two points Otrack

Single point Otrack



Polar command will have a major contribution here as well. Let’s go back to the
same dialog box:

Object Snap Tracking Settings
(® Track orthogonally only

() Track using all polar angle settings

Under Object Snap Tracking Settings, there are two choices:

e Track orthogonally only (default option)
e Track using all polar tracking settings

This means you can use the current Polar angles (increment and additional angles) to
specify points using OTRACK.

To deactivate an OTRACK point, stay at the same point again for a couple of
seconds, and it will be deactivated

NOTE

PRACTICE 2-4A DRAWING USING OSNAP AND OTRACK

1. Start AutoCAD 2016
2. Open Practice 2-4a.dwg
3. Using the proper OSNAP and OTRACK settings, create the four arcs as shown

below:



4. Create the two circles as shown below (Radius = 1)



5. Using OSNAP and OTRACK (using two points), draw the circle at the center of the
shape (Radius = 3.0)



6. Using OSNAP and OTRACK (one point) draw the two circles at the right and left
(distance center-to-center = 5.0, and Radius = 0.5)



7. Change the increment angle in the Polar Tracking dialog box to 45. Make sure that
Track using all polar angle settings is on, draw a circle (Radius = 0.5), its center
specified using OSNAP, OTRACK, and polar tracking as shown below:



8. Do the same procedure to draw a circle at the top, to end up with the final shape as
follows:



9. Save and close the file

PRACTICE 2-4B DRAWING USING OSNAP AND OTRACK

1. Start AutoCAD 2016
2. Open Practice 2-4B.dwg
3. Using the proper OSNAP and OTRACK settings, add lines and circles to make the

shape look like the following:
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4. Save and close the file

2.10 DRAWING LINES AND ARCS USING POLYLINE COMMAND

Polyline command will do all or any of the following:

e Draw both line segments and arc segments

e Draw a single object in the same command rather than drawing segments of lines and
arcs, like in Line and Arc commands

e Draw lines and arcs with starting and ending widths

To use the command, go to the Home tab, locate the Draw panel, then select the
Polyline button:



2O /T

Line |Polyline| Circle

Polyline
Creates a 2D polyline

=m PLINE

Press F1 for more help

The following prompt will appear:
Specify start point:
Current line-width is 1.0000

Specify next point or [Arc/Halfwidth/Length/Undo/
wWidth]:

AutoCAD will ask you to specify the first point, and when you do, AutoCAD will
report to you the current line-width; if you like it, continue specifying points using the
same method we learned in the Line command. If not, change the width as a first step by
typing the letter W, or right-clicking and selecting the Width option, which will bring up
the following prompt:

Specify starting width <1.0000>:
Specify ending width <1.0000>:

Specify the starting width, press [Enter], and then specify the ending width. The next
time you use the same file, AutoCAD will report these values for you when you issue the
Polyline command. The process for Halfwidth is the same, but instead of specifying the
full width, you specify halfwidth.

The Undo and Close options are identical to the ones at the Line command.
Length will specify the length of the line using the angle of the last segment.
Arc will draw an arc attached to the line segment; you will see the following prompt:

Specify endpoint of arc or [Angle/CEnter/CLose/
Direction/ Halfwidth/Line/Radius/Second pt/Undo/Width]:



The arc will be attached to the last segment of the line, or will be the first object in a
Polyline command; using either method, the first point of the arc is already known, so we
need two more pieces. AutoCAD will make an assumption (which you have the right to
reject): AutoCAD will assume that the angle of the last line segment will be considered
the direction (tangent) of the arc. If you accept this assumption, you should specify the
endpoint. If not, choose from the following to specify the second piece of information:

The Angle of the arc

The Center point of the arc

Another Direction to the arc

The Radius of the arc

The Second point which can be any point on the parameter of the arc

Based on the information selected as the second point, AutoCAD will ask you to
supply the third piece of information, but by all means it will not be out of the eight we
discussed before.

Normally the user should think counterclockwise when specifying points; on the
NOTE other hand, if you want to work clockwise, simply hold the [Ctrl] key and it will
change.

2.11 CONVERTING POLYLINES TO LINES AND ARCS, AND
VICE-VERSA

This is an essential technique which will convert any polyline to lines and arcs, and
convert lines and arcs to polylines.

2.11.1 Converting Polylines to Lines and Arcs

The Explode command, will explode a polyline to lines and arcs. To issue this
command, go to the Home tab, locate the Modify panel, then select the Explode button:

+§-¢ Move O Rotate </ Trim = _é
S Copy A Mirror ] Fillet -~ |59

[_.1 Stretch a Scale gg Array ~
Modify «

Explode

Breaks a compound object into its component objects

‘= EXPLODE

Press F1 for more help

AutoCAD will show the following prompt:
Select objects:



Select the desired polylines and press [Enter] when done. Check the new shape; you
will discover it has been changed to lines and arcs.

2.11.2 Joining Lines and Arcs to Form a Polyline

What we will discuss here is an option called Join, within a command called Edit
Polyline. To issue this command, go to the Home tab, locate the Modify panel, then select
the Edit Polyline button:

¢-§+ Move o Rotate -/ Trim ~ /

% Copy A\ Mirror (7] Fillet ~ |4y
[43 Stretch b_ Scale gg Array ~ &

ok <Pl =] VAL
= e E]
Edit Polyline

Edits polylines and 3D polygon meshes

= PEDIT

Press F1 for more help

You will see the following prompts:
Select polyline or [Multiple]:
Object selected is not a polyline
Do you want to turn it into one? <¥Y>

Enter an option [Close/Join/Width/Edit vertex/Fit/
Spline/Decurve/Ltype gen/Reverse/Undo]: J

Start first by selecting one of the lines or arcs you want to convert. AutoCAD will
respond by telling you that the selected object is not a polyline, giving you the option to
convert this specific line or arc to a polyline. If you accept this, options will appear, and
one of these options is Join. Select the Join option, then select the rest of the lines and
arcs. At the end press [Enter] twice. Check the objects after finishing; you will find that
they were converted to polylines.



PRACTICE 2-5 DRAWING POLYLINES AND CONVERTING

1. Start AutoCAD 2016
2. Open Practice 2-5.dwg
3. Draw the following polyline using a start point of 18,5, and width = 0.1

1

3.9

18,5 10

4. Then explode the polyline. The width will disappear
5. Check the objects after exploding; they are now lines and arcs
6. Save and close

2.12 USING SNAP AND GRID TO SPECIFY POINTS
ACCURATELY

Snap and Grid will be the third method to help us specify points accurately in the XY
plane.

By default, the mouse is not accurate, so we can’t depend on it to specify points. We
need to control its movement, which is the sole function of Snap. Snap can control the
mouse to jump in the X and Y plane with exact distances.

The grid by itself is not an accurate tool, but it will complement the Snap function. It
will show horizontal and vertical lines replicating the drawing sheets. In order to turn
Snap on/off, use the following button in the status bar:

Snap to drawing grid - On
SNAPMODE (F9)

23.8622,10.6816,0.0000 dif i v L & ~ \lp\ v £ U~



In order to turn the Grid on/off, use the following button in the status bar:

Display drawing grid - Off
GRIDMODE (F7) -

24.8157, 10.8329, 0.0000 5115 L @-N\N-21-

Most likely, switching both on will not help; you will need to modify the settings to
set your own requirements. Using the small triangle at the right of the Snap button, you
will see the following:

Polar Snap
v Grid Snap

Snap Settings...

Select the Snap Settings option; the Drafting Settings dialog box will pop up:



| Snap and Grid |Polar Tracking | Object Snap | 3D Object Snap | Dynamic Input | Quic < [ |
| [JSnap On F9) []Grd On (F7)
Snap spacing Grid style
. Display dotted grid in:
X P
Snap X spacing - ) [ 12D model space
Snap Y spacing: [ | [_] Block editor

[¥] Equal X and Y spacing [] SheetAayout

Grid spacing
Polar spacing Grid X spacing:

Gnid Y spacing:
Major line every:
Grid behavior
[v] Adaptive grid
[_] Allow subdivision below grid
spacing
Display grid beyond Limits
[ ] Follow Dynamic UCS

Input the Snap X Spacing and Snap Y Spacing (by default they are equal). Switch off
the checkbox to make them unequal. Do the same for the Grid Spacing in X and Y. If you
want the Grid to follow Snap, set the Grid spacing to zeros. In the Grid there are major
and minor lines; set the major line frequency.

Set if you want to see the Grid in dots (as it was before AutoCAD 2011) and where
(2D Model space, Block editor, or Sheet layout).

Grid behavior is for 3D only.
Specify the type of Snap: Grid Snap or Polar Snap.
The user can use function keys to turn on/off both Snap and Grid:

e F9 = Snap on/off
e F7 = Grid on/off

2.13 USING POLAR SNAP




While using the Snap command, the mouse will use the increment distance to specify
the exact distance only in horizontal and vertical directions. While going diagonally, Snap
will not help you. To solve this problem AutoCAD provided the concept of Polar Snap,
which will specify exact increments using all the angles specified in the Polar Tracking
dialog box. To activate the Polar Snap, AutoCAD will switch off the normal Snap (which
is called Grid Snap). To do that go to the Snap button, click the triangle at the right of the
button, and select the Snap Settings option, which will bring up the following dialog box:

[_]Snap On (F9)

Snap spacing
Snap A spacing 0.5000

Snap Y spacing 0.5000

[v] Equal X and Y spacing

Polar spacing

Polar distance:

Major line every:
Snap type
Adaptive grid
[ ] Allow subdivision below grid
Isometric ghap spacing
Display grid beyond Limits
®) PolarSnap [ ] Follow Dynamic UCS

® Rectangularnap

Select the Polar Snap button, then specify the the Polar distance as shown in the
above illustration.

PRACTICE 2-6 SNAP AND GRID

1. Start AutoCAD 2016

2. Open Practice 2-6.dwg

3. Change Polar Tracking to use angle = 45

4. Change the Snap to Polar Snap and set the distance to 0.5



5. Draw the following shape, bearing in mind to start from point 22,5, make all segment
lengths 6.5, and use an angle of 45:

225

6. Save and close the file

PRACTICE 2-7 SMALL PROJECT

1. Start AutoCAD 2016

2. Start a new drawing using acad.dwt

3. Using all the commands and techniques you learned in Chapter 2, draw the following
drawing (without dimensions) starting from any point you wish:



This is Polyline —\
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4. Save and close the file

NOTES

CHAPTER REVIEW

1. Polyline command is different from Line command in the following way(s):
1. Tt will produce lines and arcs
2. All segments drawn using the same command are considered a single object
3. You can specify a starting and ending width
4. All of the above
2. Perpendicular, Tangent, and Endpoint are some available in
AutoCAD
3. OTRACK can work by itself:
1. True
2. False
4. One of the following is not part of the eight pieces of information AutoCAD needs to
draw an arc:
1. End point of the arc
2. Midpoint of the arc
3. Center point of the arc
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4. Angle

To convert to lines and arcs from a polyline, use command
If you want the Grid to follow the Snap setting, set it up to be in both X and
Y

Using the Polar Tracking dialog box, the user can only track orthogonal angles:
1. True
2. False
is always required to draw an arc
To convert lines and arcs to polylines use:
1. Polyline Edit, Convert option
2. Polyline Edit, Union option
3. Polyline Edit, Join option
4. None of the above

CHAPTER REVIEW ANSWERS

1.d
3.b
5. Explode
7.b
9.C



CHAPTER 3

MODIFYING
COMMANDS PART I

In This Chapter

Different methods to select objects, and selection cycling
How to erase objects

How to move and copy objects

How to rotate and scale objects

How to mirror and stretch

How to lengthen and join objects

How to use grips for editing

3.1 HOW TO SELECT OBJECTS IN AUTOCAD

In order to use any of the modification commands discussed in this chapter, you have
to select “desired objects” as the first step. Once you issue any of the modifying
commands, the following prompt will appear:

Select objects:

The cursor will change to the Pick Box. At this prompt, you can work without typing
anything at the keyboard, or can type few letters to activate a certain mode.

Without typing any letter, you can do the following things:

e Select objects by clicking them using the pick box one by one

e Without selecting any object, click and move to the right to start Window mode,
which will select all objects contained fully inside the Window

e Without selecting any object, click and move to the left to start Crossing mode, which
will select all objects contained fully inside the Crossing, or touched (crossed) by it

Check the following two examples:

Window Example:



At the cursor you will see a small rectangle with blue circle inside it. All objects will
be selected except the big circle and the bottom diagonal lines, but why? Because they are
not fully contained inside the window.

Crossing Example:

At the cursor you will see a small rectangle crossing the green circle. All objects will
be selected except the two diagonal lines at the left along with the arc and circle, but why?
Because they were neither contained nor crossed.

Another way to use the Select objects prompt is to type a few letters to activate a
certain mode; these letters are:

3.1.1 Window Mode (W)




At the command prompt, typing W will switch the selecting mode to the Window,
which will be available whether you go to the right or to the left.

3.1.2 Crossing Mode (C)

At the command prompt, typing C will switch the selecting mode to the Crossing,
which will be available whether you go to the right or to the left.

3.1.3 Window Polygon Mode (WP)

WP mode will specify a non-rectangular window when you specify points in any
fashion you like. By typing WP and pressing [Enter], the following prompts will appear:

First polygon point:
Specify endpoint of line or [Undo]:
Specify endpoint of line or [Undo]:

Press [Enter] to end WP mode. WP is just like W; it needs to contain the object fully
in order to select it.

Check the following example:



O

Only four circles will be selected, which are fully contained inside the WP.

3.1.4 Crossing Polygon Mode (CP):

Since there is W and WP, certainly there is C and CP. Crossing Polygon is just like
WP, and will specify a non-rectangular shape to contain and cross objects. Check the
following illustration:



Three circles will be selected because they are fully contained inside the CP, and
three more will be selected because they are crossed by the CP.

3.1.5 L.asso Selection

The user can combine the WP and CP modes without typing any letter. While the
pick box is displayed, click and hold; if you go to the right, you have WP, if you go to the
left, you have CP, but with an irregular shape just like the example below:



3.1.6 Fence Mode (F)

Fence mode will select multiple objects by crossing (touching) them. Lines in Fence
mode can cross each other, contrary to WP and CP. Check the following example:



All the circles are selected because they are touched by the fence. The vertical line at
the right will be selected as well. You can see that the fence lines are crossed which is

100% acceptable in AutoCAD.
3.1.7 Last (L), Previous (P), and All Modes

Furthermore, you can select objects using the following modes:

e Last (L): To select the last object drawn
e Previous (P): To select the last selected objects
e All: To select all objects in the drawing

NOTE

3.1.8 Other Methods to Select Objects

To deselect objects, hold the [Shift] key on the keyboard and click these objects.
While you are in this mode, you can use window and crossing.



There are two ways to use Modifying commands, either to issue the command and
then select objects, or to select objects and then issue the command. This technique is
called the Noun/Verb technique. Without issuing any command, you can:

Select a single object by clicking it

Click an empty space and go to the right to get to Window mode
Click an empty space and go to the left to get to Crossing mode
Click an empty space, then type W to get to Window polygon mode
Click an empty space, then type C to get to Crossing polygon mode
Click an empty space, then type F to get Fence mode

When you select objects, you can go to the Home tab, locate the Modify panel, and
issue the desired command, or you can right-click to get a shortcut menu that contains five
modifying commands: Erase, Move, Copy Selection, Scale, and Rotate, as shown below:
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By default, Noun/Verb is working, but if you want to know how to control it, do the

following steps:

e Go to the Application Menu and select the Options button
e Choose the Selection tab
e Under Selection modes, make sure that Noun/Verb selection is on



Selection modes
Noun/verb selection

|| Use Shift to add to selection
Object grouping
[_] Associative Hatch
Implied windowing
|| Allow press and drag on object
Window selection method:
Both - Automatic detection v

25000 Object limit for Properties palette

Use this part as well to do the following:

e Turn on Allow press and drag on object to allow you to create a window or
crossing even if the cursor is not over a clean spot for picking

e Under Window selection method, make sure that Both-Automatic detection is
selected so if you click then release the mouse, or if you click and drag, either
method will be accepted

3.2 SELECTION CYCLING

While we are drafting using AutoCAD, we may unintentionally draft objects over
each other, or we may click on an object using a point that is sharable by other objects.
This issue used to be a problem in the past, but not anymore. AutoCAD provides us with
Selection Cycling, which will notify us if our click touched more than one object, and will
give us the ability to pick the desired one. To activate Selection Cycling (by default it is
active), go to the Drafting Settings dialog box—which we used in Snap, Grid, OSNAP,
etc.—and select the last tab titled Selection Cycling as shown below:




Selection Cycling - Off
SELECTIONCYCLING
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After activating, and when you click on one object, you may see the following:

[‘pﬂ Selection .'

|l Circle |

B Hatch

None

The small window will tell you there are two possible objects at the click position,
Circle and Hatch, and that Circle is now selected. Using this window, if you move the
mouse to Hatch, you will get the following picture:



B Cicle

3.3 ERASE COMMAND

The Erase command will delete any object you select. To issue the command go to
the Home tab, locate the Modify panel, and then select the Erase button:

*E* Move O Rotate -/ Trim =~
% Copy A\ Mirror (7] Fillet ~

[..l Stretch E"T_l Scale gg Array ~
Modify ~

Erase

Removes objects from a drawing

‘= ERASE
Press F1 for more help

You will see the following prompt in the command window:
Select Objects:

If you use the one-by-one method, you will see that the cursor changes to the
following shape:



Select the desired objects. The Select Objects prompt is repetitive, so you always
need to end it by pressing [Enter] or right-clicking.

You can erase using other methods:

e Click on the desired object(s), and then press [Del] key at the keyboard
e Click on the desired object(s), right-click, and select Erase from the shortcut menu:
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PRACTICE 3-1 SELECTING OBJECTS AND ERASE
COMMAND

1. Start AutoCAD 2016
2. Open Practice 3-1.dwg



3. Start Erase command (for all steps, after you finish selecting, press [Enter] then

Undo)
4. Without typing any letter, find an empty space at the left, click (release your finger,

don’t hold the mouse button down) and go the right. Try to get the following result:

First Pont Go to the nght

/\ ‘ / \ Second Point

5. What was selected? Did you expect this result?
6. Do the same steps to simulate the following picture:



Go to the left

7. What was selected and why?

8. Try to simulate the following picture using WP:



O

9. Try to simulate the following picture using CP:



10. Try to simulate the following picture using Fence:



11. Without issuing the Erase command, select objects, then press [Del] at the keyboard
to delete them. Undo what you did.

12. Without issuing the Erase command, select objects, then right-click and select the
Erase command from the menu. Undo what you did.

13. Start the Erase command and select objects, then hold [Shift] to deselect some of the
selected objects and press [Enter]. Undo what you did.

14. Close the file without saving

3.4 MOVE COMMAND

This command will move objects from one place to another in the drawing. To issue
this command, go to the Home tab, locate the Modify panel, and then select the Move
button:
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Move

Moves objects a specified distance in a specified direction

‘mm MOVE

Press F1 for more help

The following prompts will be shown to you:

Select objects:
Specify base point or [Displacement] <Displacement>:

Specify second point or <use first point as
displacement>:

The first step is to select objects, and then the user should select the Base Point. The
base point is the point that will represent the objects; it will move a distance and angle,
and the objects will follow. The main objective of the Base point is accuracy.

After you select the Base point the cursor shape will change to the following:
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The last prompt will ask you to specify the second point or the destination of your
movement.

3.4.1 Nudge Functionality

This function is very simple and will enable you to make an orthogonal move for
selected objects. All you have to do is to select objects, hold the [Ctrl] key at the
keyboard, and then use the four arrows at the keyboard; you will see objects move toward



the desired direction.

PRACTICE 3-2 MOVING OBJECTS

1. Start AutoCAD 2016

Open Practice 3-2.dwg

3. Using the Move command, move the three circles and the rectangle to the right
places so you will get the following result (you will be needing Osnap and Otrack to
move the rectangle accurately)
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4. Save and close the file

3.5 COPY COMMAND

This command will copy objects. To issue this command, go to the Home tab, locate
the Modify panel, then select the Copy button:

"E" Move () Rotate -/ Trim ~ _/_
D&) c“FL(J Alh Mirror Q Fillet ~ #5p
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Copy
Copies objects a specified distance in a specified direction

' COPY

Press F1 for more help




You will see the following prompts:

Select objects:
Current settings: Copy mode = Multiple

Specify base point or [Displacement/mode]
<Displacement>:

Specify second point or [Array] <use first point as
displacement>:

Specify second point or [Array/Exit/Undo] <Exit>:
Specify second point or [Array/Exit/Undo] <Exit>:

After you select the desired objects, AutoCAD will report to you the current mode,
which in our case is Multiple. This mode means the user will be able to create several
copies in the same command. The other mode is Single copy. The first prompt will ask to
specify the base point. AutoCAD then will ask you to specify the second point to complete
a single copy process, then repeats the prompt to create another one, and so on. There are
three options you can use:

e Undo, to undo the last copy

e Exit, to end the command

e Array, which will create an array of the same object using distance and angle. When
you select the array option you will see the following prompts:

Enter number of items to array:
Specify second point or [Fit]:

The first prompt is to input the number of items in the array (including the original
object); the second is to specify the distance between the objects. The user can use the Fit
option in order to specify the total distance, and AutoCAD will equally divide the distance
over the number of objects.

After you select the Base point, the cursor shape will change to the following:
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@ PRACTICE 3-3 COPYING OBJECTS




1. Start AutoCAD 2016

Open Practice 3-3.dwg

3. Copy the door using multiple copying, and copy the toilet using the Array option (use
the Midpoint OSNAP for the toilet), to achieve the following:
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4. Save and close the file

3.6 ROTATE COMMAND

This command will rotate objects around the base point, using the rotation angle or
reference. To issue the command go to the Home tab, locate the Modify panel, and select
the Rotate button:
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Rotates objects around a base point

‘=m ROTATE

Press F1 for more help

You will see the following prompts:
Current positive angle in UCS:
ANGDIR=counterclockwise ANGBASE=0
Select objects:
Select objects:



Specify base point:
Specify rotation angle or [Copy/Reference] <0>:

The first message is to tell you about the current angle direction and Angle Base

value. The base point here is the rotation point; all the selected objects will rotate around
it.

Use the Copy option to make a copy of the selected objects, and then rotate them.

After you select the Base point, the cursor shape will change to the following:
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3.6.1 Reference Option

This option is very helpful if you don’t know the rotation angle; instead, you can
specify two points to indicate the current angle, and two points to input the new angle.
You will see the following prompts:

Specify the reference angle <0>:
Specify second point:
Specify the new angle or [Points] <0>:

You can input the angle by typing. If you want to input angles using two points, the
first point you will pick will be for both angles, the current and the new. Check the
following illustration:



Current Angle

" Point 3

PRACTICE 3-4 ROTATING OBJECTS

Start AutoCAD 2016

. Open Practice 3-4.dwg

. Rotate the lower window using Angle

. Rotate the upper window using Reference

. Rotate the chair with Copy mode to get the following result:
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3.7 SCALE COMMAND

This command will create bigger or smaller objects using the scale factor or the
reference. To issue this command, go to the Home tab, locate the Modify panel, then
select the Scale button:

6. Save and close the file
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Scale

Enlarges or reduces selected objects,